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Chapter 3 File Creation 

This chapter covers the creation and setup of New ORD Files. 
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RECORD OF REVISIONS 

The following record of revisions to the OpenRoads Designer Manual Chapter 3 is offered as a “quick reference” to 
determine the latest changes. 

DATE SECTION REVISION DESCRIPTION 

4/2025 Section 3B.2 Update step 7 of where to locate the Seed File in the Workspace 

Section 3B.3 Survey Unit requirements for new projects starting January 1, 2023 
were revised. 

Section 3C.1 Project Specific Prefix: Updated website link 

Section 3E.1 Google Earth Warning: Updated website link 
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3A – NEW ORD FILE CREATION FLOW CHART 

This flowchart shows the processes involved for creating and setting up a new ORD File. 
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3B – CREATE A NEW ORD FILE 

3B.1 Create a New ORD File – Non-ProjectWise Users 

New ORD Files should be created from the WorkSpace/WorkSet Menu.  Accessing the 
WorkSpace/WorkSet Menu is shown in 1A.1 Opening the Software and WorkSpace/WorkSet Menu. 

WARNING: The most important step in this procedure is setting the appropriate Seed File for the new 
ORD File, which is shown in step 5.  The Seed File MUST correspond with the Survey Units used for the 
project (i.e., International Feet or Survey Feet).  If the WRONG Survey Units Seed File is used, then 
the NEW ORD File will NOT be in the correct geographic position.  The Seed File CANNOT be 
changed after creation of an ORD File. 

Also, a Seed File can be 2D or 3D.  If a 2D Seed File is selected, then the new ORD File will initially contain 
a 2D Design Model .  For a 2D Seed File, a 3D Design Model  is automatically created when the 
Existing Ground Terrain Model is activated.  A 2D Seed File is appropriate for Corridor, 3D modeling, and 
conventional drafting applications because it can accommodate both 2D and 3D elements. In MOST 
situations a 2D Seed File should be selected. 

If a 3D Seed File is used, then the ORD File initially contains a 3D Design Model .  Consequently, 2D 
(horizontal) drafting CANNOT be performed with a 3D Seed File.  The 3D Seed File is very seldomly used.  
For more information on the Seed File, see 3B.3 The Seed File. 

 

 

Open the WorkSpace/WorkSet Menu.  Ensure the FLH WorkSpace is shown in the WorkSpace 
drop-down.  Expand the WorkSet drop-down and select the project WorkSpace to which the 
new ORD File should be assigned to. 

NOTE: If the project WorkSpace is NOT shown in the WorkSet drop-down, then create it using 
the process shown in 2D – Create a Project WorkSet – Non-ProjectWise Users. 

NOTE: A new ORD File can also be created by selecting File > New.  If this method is used, then 
the new ORD File is automatically assigned to the active WorkSpace and WorkSet.  For more 
information on the WorkSpace and WorkSet, see 2B – Introduction to the WorkSpace and 
WorkSet. 

 
Select the New File button. 
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Navigate to the project Folder Location for placement of the new ORD File. 

 

Assign the new ORD File a File Name. 

IMPORTANT: ORD Files MUST be named in accordance with the agency’s File Naming 
Convention.  See 3C – ORD File Naming Conventions. 

 

Assign the new ORD File the appropriate Seed File.  See the WARNING on the previous page 
and 3B.3 The Seed File.  The Seed File must correspond to the project Survey Units (Survey 
Feet or International Feet).  In most situations, a 2D Seed File is used. 

Click Browse to navigate to the Seed File folder location. 

Seed Files are found in the FLH WorkSpace, in the following file location: 
C:\OpenRoads Designer CE 10.10\Configuration\Organization-Civil\FLH_Stds-WS10.10.21.00V\Seed\ 

 
Push the Save button to create the new ORD File. 



 

3-6 

3B.2 Create a New ORD File - ProjectWise Users 

IMPORTANT: Before creating a new ORD File, ensure that that ORD Software is logged in and connected 
to ProjectWise server.  See 2C - Working In and Outside Of ProjectWise. 

New ORD Files should be created from the WorkSpace/WorkSet Menu.  Accessing the 
WorkSpace/WorkSet Menu is shown in 1A.1 Opening the Software and WorkSpace/WorkSet Menu. 

WARNING: The most important step in this procedure is setting the appropriate Seed File (Source 
File) for the new ORD File, which is shown in step 7.  The Seed File MUST correspond with the Survey 
Units used for the project (i.e., International Feet or Survey Feet).  If the WRONG Survey Units Seed 
File is used, then the NEW ORD File will NOT be located in the correct geographic position.  The 
Seed File CANNOT be changed after creation of an ORD File 

Also, a Seed File can be 2D or 3D.  If a 2D Seed File is selected, then the new ORD File will initially contain 
a 2D Design Model .  For a 2D Seed File, a 3D Design Model  is automatically created when the 
Existing Ground Terrain Model is activated.  A 2D Seed File is appropriate for Corridor, 3D modeling, and 
conventional drafting applications because it can accommodate both 2D and 3D elements. In MOST 
situations a 2D Seed File should be selected. 

If a 3D Seed File is used, then the ORD File initially contains a 3D Design Model .  Consequently, 2D 
(horizontal) drafting CANNOT be performed with a 3D Seed File.  The 3D Seed File is very seldomly used.  
For more information on the Seed File, see 3B.3 The Seed File. 
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Open the WorkSpace/WorkSet Menu.  Ensure the FLH WorkSpace is shown in the WorkSpace 
drop-down.  Expand the WorkSet drop-down and select the project WorkSpace to which the 
new ORD File should be assigned to. 

NOTE: If the project WorkSpace is NOT shown in the WorkSet drop-down, then contact the 
Engineering System manager. 

NOTE: A new ORD File can also be created by selecting File > New.  If this method is used, then 
the new ORD File is automatically assigned to the active WorkSpace and WorkSet.  For more 
information on the WorkSpace and WorkSet, see 2B – Introduction to the WorkSpace and 
WorkSet. 

 Select the New File button. 
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Assign the new ORD File to the appropriate Project Folder.  Push the Change… button and 
navigate to the project folder. 

 

Assign the new ORD File an appropriate Name and File Name.  WARNING: The Name and File 
Name must exactly match.  In the Name text box, the User is required to manually type in the 
“.dgn” file extension. 

IMPORTANT: ORD Files MUST be named in accordance with the agency’s File Naming 
Convention.  See 3C – ORD File Naming Conventions. 

 

Assign the new ORD File a Description. A brief Description will help other Users understand the 
contents of the ORD File. 

A Description for an ORD File named “id- a436805_hyd.dgn” that pertains to proposed culverts 
may be: “Alignments and profiles for all proposed culverts in the project.”  

 
Ensure the Application is set to “OpenRoads Designer.  NOTE: The Department drop-down is 
not utilized.  Ensure the Department is set to “<none>”. 

 

The Source File represent the Seed File too be used.  By default, the Seed File is set to a 2D 
Seed File of the appropriate Survey Unit (i.e., Survey Feet or International Feet. 

The Source File only needs to be changed if the 3D Seed File is to be used.  For more 
information on the Seed File, see 3B.3 The Seed File. 

If the 3D Seed File needs to be used, manually alter the Source File text.  Highlight the “2” in 
the Source File text, and replace it with a “3”.  For example, manually change: 

…Configuration\Organization-Civil\FLH_Stds-WS10.10.21.00V\Seed\International\SurvFt-2D.dgn 

to 

…Configuration\Organization-Civil\FLH_Stds-WS10.10.21.00V\Seed\International\SurvFt-3D.dgn 

 Push the Apply button. Push the OK button to create the new ORD File. 



 

3-9 

3B.3 The Seed File 

New ORD Files need to be created using the appropriate Seed File.  A Seed File is a blank drawing that 
contains pre-configured geo-spatial settings relating to the project Survey Units (i.e., International Feet or 
Survey Feet). 

Two factors influence the selection of the appropriate Seed File for a new ORD File: 

1. The Survey Units used for the project.  The Survey Units is either Survey Feet or 
International Feet.  International Feet units are used in all states for projects starting after 
January 1st, 2023.  

2. 2D or 3D Seed Files.  If a 2D Seed File is used, then the ORD File initially contains a 2D Design 
Model .  If a 3D Seed File is used, then ORD File initially contains a 3D Design Model . 

NOTE: 3D Seed Files are ONLY used for a few tasks, such as creating the Survey ORD File and the 
Proposed Terrain Model ORD File (see Chapter 22 – Proposed Terrain Model Creation).  2D Seed Files are 
used for all other ORD File Types.  When in doubt, use the 2D Seed File.  The appropriate 2D or 3D Seed 
File for all ORD File Types is listed in 3C.4 ORD File Types. 

 

Seed Files are located in the FLH WorkSpace in the following location: 

…\OpenRoads Designer CE 10.10\Configuration\Organization-Civil\FLH_Stds-WS10.10.21.00V\Seed\ 

WARNING: The Seed File can only be specified during the File Creation process.  Once an ORD File is 
created, the Seed File CANNOT be exchanged.  If the incorrect Seed File is used, the geometric elements 
within ORD File will not align with the project survey Coordinate System – resulting in an ORD File that is 
NOT geo-referenced.  If the Seed File is set to the incorrect Survey Units, then the ORD File 
should be deleted. 
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3C – ORD FILE NAMING CONVENTIONS 

3C.1 WFLHD ORD File Naming Convention 

The format for the WFL ORD File Naming Convention is: 

Project Specific Prefix + File Type Suffix + Extension. 

Example Project File Name:  id-a2158061_pln_pp.dgn 

 [Project Specific Prefix] _ [File Type Suffix] . [Extension] 
 [id-a21158061]  [pln_pp]  [dgn] 

Project Specific Prefix: The Project Specific Prefix for active WFLHD projects can be looked up on the 
FLH Website: https://highways.dot.gov/federal-lands/design/plan-prep/wfl/naming/active-project-prefixes  

File Type Suffix: The File Type Suffix is determined by the ORD File Type (See 3C.4 ORD File Types) 
and the Functional Design Area Code (See 3C.5 Functional Design Area Code). 

Extensions: The file extension corresponds to the software used to create a Project File.  ORD Files 
have a [.dgn] file extension.  Do NOT change the default file extension (i.e. DGN, DOCX, XSLX, or PDF). 

3C.2 EFLHD ORD File Naming Convention 

The format for the EFL ORD File Naming Convention is: 
Section Number Descriptor + Project Number + File Type Suffix + Extension. 

Example Project File Name: 01_GRSM_126_MillCrk_pln_pp.dgn 

[Section Number Descriptor] _ [Project Number] _ [File Type Suffix] . [Extension] 
 [01] [GRSM_126_MillCrk] [pln_pp] [dgn] 

Section Number Descriptors: Represents the functional 
discipline of the ORD File.  See the table to the right. 

Project Number: The Project Number is the unique code 
assigned to all EFLHD projects. 

File Type Suffix: The File Type Suffix is  determined by the 
ORD File Type (See 3C.4 ORD File Types) 

Extensions: The file extension corresponds to the software 
used to create a Project File.  ORD Files have a [.dgn] file 
extension.  Do NOT change the default file extension (i.e. DGN, 
XSLX, or PDF). 

EFL Section Number Descriptor 
Descriptor Discipline 

01 Highway Design  

02 Survey 

03 Hydraulics 

04 Safety/Environmental 

05 Geotechnical 

06 Traffic/Pavement 

07 Bridge 

08 Construction 

09 A&E (Consultant) 

https://highways.dot.gov/federal-lands/design/plan-prep/wfl/naming/active-project-prefixes
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3C.3 CFLHD ORD File Naming Convention 

(Place Holder) 

3C.4 ORD File Types 

In general, there are three ORD File Types that are used in a project: 

• Survey ORD Files (See 3C.4.a) 

• Design ORD Files (See 3C.4.b) 

• Plan Sheet ORD Files (See 3C.4.c) 

For a visual representation of Project Organization and the Referencing interaction between ORD File 
Types – see 2F.1 Project Organization and Referencing Map for ORD Files. 

3C.4.a Survey ORD Files 

Survey ORD Files contain the existing survey features, linework, and the Existing Ground Terrain Model. 

Survey ORD Files are referenced into Design ORD Files and Plan Sheet ORD Files.  Elements in the Survey 
ORD File should ONLY be modified by the Survey Department. 

 For more information on the Existing Survey File, see Chapter 5 – Survey Process and Terrain ORD File 
Development. 

  Existing Survey File Naming  
File Type File Suffix Purpose and Contents Seed File 

Survey _sur.dgn 

Existing survey terrain model and planimetric linework. 

Includes existing utilities, signage, and contours. 

Also includes surveyed points and break lines.  

3D 

Right of Way e_row.dgn 
Existing Right of Way linework. 

Includes Boundaries, Parcels, Section, Township and Range. 
2D 
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3C.4.b Design ORD Files 

Design ORD Files contain proposed design elements such as alignments, profiles, corridors, 
superelevation, cross-sections, quantities calculations, proposed terrain models, and 2D/3D linework. 

Design ORD Files should NOT be used to create Plan Sheets.  Instead, Design ORD Files should 
be referenced into Plan Sheets ORD Files. 

WFLHD Users: Design ORD Files can be further classified by a Functional Design Area Code.  The 
Functional Design Area Code pertains to the discipline (i.e., hydraulics, bridges) that the ORD File is used 
for.  See 3C.5 Functional Design Area Code. 

  Proposed Design File Naming  
File Type File Suffix Purpose and Contents Seed File 

Alignments _ali.dgn 

Proposed alignment and profiles. 

Contains the proposed mainline alignment and 
profile.  Typically contains stationing and curve 
data annotations. 

2D 

Corridor _cor.dgn 

Proposed corridor modeling file. 

Contains proposed corridor model used to create 
cross sections.  Also includes proposed linework – 
including edge of road and slope stakes (cut/fill).  

2D 

Civil Cell and 
Intersections 

_cvc.dgn 

Civil Cells, intersections, and approach road 
models to supplement the proposed corridor model 
(_cor.dgn). 

Contains proposed intersection alignments, 
profiles, and corridors models.  

2D 

Superelevation _sup.dgn 

Superelevation File 

Contains superelevation elements and calculations 
that are applied to the proposed corridor model 
(_cor.dgn) 

2D 

Cross Sections _xs.dgn 

Cross Section File. 

Contains cross section Named Boundaries and 
Sheet Models.   Used to create Road Cross Section 
Sheets. 

2D 

Quantities _qty.dgn 

Quantity and Earthwork calculation file. 

Contains Named Boundaries for Element 
Component quantity calculations.  Also contains 
Cut and Fill Meshes for earthwork calculations. 

2D 

Proposed 
Right of Way 

_p_row.dgn 
Proposed Right-of-Way file. 

Contains linework for the Proposed Right of Way. 
2D 
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3C.4.c Plan Sheet ORD Files 

Plan Sheet ORD Files are used to create bordered Plan Sheets (Sheet Models ) that will be incorporated 
into the Plan Set. 

All Plans Sheets ORD Files contain  “_pln” included in the File Name.  Example Plan Sheet ORD File name: 

id-a2158061_pln_pp.dgn OR ak-r-izm7050901_pln_typ.dgn 

WFLHD Users: Plan Sheet ORD Files can be further classified according to the Functional Design 
Area Code.  See 3C.5 Functional Design Area Code. 

BEST PRACTICES: Do NOT draw or place design elements in a Plan Sheet ORD File.  The exception to 
this convention is the Typical Section file and files that show details.  Linework elements used to create 
Typical Sections graphics are NOT referenced into other ORD Files.  In general, if design or linework 
elements are to be referenced into other ORD Files, then a Design ORD File should be created. 

Plan Sheet ORD Files should NOT be referenced into Design ORD Files or other Plan Sheet ORD 
Files. 

  Plan Sheet File Naming 
File Type File Suffix Purpose and Contents 

General _gen.dgn 

Plan Sheets to create the General Information of a Plan Set. 

Typically includes the Title Sheet, Sheet Index, Vicinity Maps, and Material 
Sources. 

NOTE: All general sheets can be created in a single ORD file. 

Typical 
Section 

_typ.dgn 
Plan Sheets to create the Typical Sections of a Plan Set. 

Linework for roadway typical section schematics are drawn in this ORD File. 

Plan and 
Profile 

or 

Plan and Plan 

_pp.dgn 

Plan Sheets to create Plan & Profile or Plan & Plan sections in a Plan Set. 

Contains plan and profile drawing and sheet models.  Also contains Profile 
Annotations including vertical curve labels, and grids lines. 

May also be used to create Plan and Profile sheets for 
intersections/approaches OR Plan and profile sheets needed for other 
functional areas. 

Quantity 
Tabulation 

_qtab.dgn 
Plan Sheets to create the Tabulation of [Plan Set Section] Quantities sheets 
that may serve as the first sheet of a Section.  

Erosion 
Control 

_ec.dgn 

Plan or Plan/Plan Sheets to create the Soil Erosions and Sediment Control 
Section of a Plan Set. 

Used to create linework for Erosion Control features - such as silt fence  

Drainage 
Details 

_hy.dgn 
Plan Sheets to show Tables and create details found in the Drainage 
Section of a Plan Set. 

Temporary 
Traffic 
Control 

_ttc.dgn 

Plan Sheets to create the Temporary Traffic Control Section of a Plan Set. 

Also used to create Temporary Traffic Control schematics, maps, line 
graphs, and linework. 
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  Plan Sheet File Naming 
File Type File Suffix Purpose and Contents 

Permanent 
Traffic 
Control 

_ptc.dgn 

Plan Sheets to create the Permeant Traffic Control Section of a Plan Set. 

Also used to create linework pertaining to proposed Permeant Traffic 
Control features – such as striping and signage. 

Right of Way _rw.dgn 

Plan Sheets to create the Right of Way Plan Sets and Exhibits. 

NOTE: Proposed Right of Way linework is created in the _p_row Proposed 
Design File. 

Landscaping _lscp.dgn 

Plan Sheets to create the Landscaping Section of a Plan Set. 

Also used to create linework and graphics pertaining to proposed 
landscaping features. 

Miscellaneous  _misc.dgn Plan Sheets to create the Miscellaneous Details Section of a Plan Set. 

Wall _wall.dgn 

Plan Sheets to create the Retaining Walls Section of a Plan Set. 

May contain plan and profile drawing and sheet models for the proposed 
Wall Design. 

BEST PRACTICE: Create linework and models for retaining walls in a 
Proposed Design File.  

Staging  _stage.dgn 
Plan Sheets to create the Staging Section of a Plan Set. 

Also used to create linework pertaining to Staging features. 

Demolition _demo.dgn 

Plan Sheets to create the Demolition Section of a Plan Set. 

Also used to create linework associated with existing feature removal and 
demolition. 

Utilities _ut_ 
[type].dgn 

Plan Sheets to create the Utilities Sections Exhibits. 

An additional description should be used to denotate the utility type.  An 
example for a utility plan showing fiber optic cable would be - ut_fiber.dgn 

Standard 
Details 

157-7 
Standard Detail to be incorporated throughout a Plan Set. Standard Detail 
file names should not be changed.   
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3C.5 Functional Design Area Code 

A Functional Code is used to further organize ORD Files by Functional Area or engineering discipline. The 
Functional Code is placed between the Project Specific Prefix and File Type Suffix 

An example Proposed Design File Name using a Functional Code may look like: 

id-a2158061_geo_cor.dgn 

[Project Specific Prefix] _ [Functional Code] _ [File Type Suffix] .  [Extension] 
 [id-a21158061] [geo] [cor] [dgn] 

The “geo” functional code is used for Geotechnical design.  For example, a retaining wall design would be 
placed in an ORD File with the “geo” functional code specified in the file name. 

An example Plan Sheet File Name using a Functional Code may look like: id-a2158061_hyd_pln_pp.dgn 

[Project Specific Prefix] _ [Functional Code] _ [File Type Suffix] .  [Extension] 
 [id-a21158061] [hyd] [pln_pp] [dgn] 

The ‘hyd” functional code is used for Hydraulics plan sheet production. 

NOTE: Functional Codes are not required for the Highway Design functional area.  If a functional code is 
NOT included in the file name, then the Highway Design functional area is assumed. 

Functional Codes for File Names 
Code Functional Area 

(blank) 
Highway Design and general use is 
implied by lack of Functional Code 

_hyd Hydraulics 

_sur Survey 

_brd Bridge 

_geo Geotechnical 

_rw Right of Way 

_utl Utilities 
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3D – SETUP A NEW ORD FILE 

After creating an ORD File, the following three procedures should be performed immediately: 

1. Assign the new ORD File to the appropriate Coordinate System (See 3D.1 Set the Coordinate 
System) for ORD Files that need to be geo-referenced. 

NOTE: ORD Files used for detail drafting and typical sections do NOT require the Coordinate 
System to be set.  In general, the Coordinate System must be set to ensure the ORD File is 
placed in the correct geographical location. 

2. Reference the Survey ORD File and necessary Design ORD Files (See 3D.2 Reference in the 
Survey ORD Files and Design ORD File). 

3. Activate the Existing Ground Terrain Model (See 3D.3 Activate the Existing Ground Terran Model) 
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3D.1 Set the Coordinate System 

Before drafting or referencing other ORD Files into the new ORD File, set the project Coordinate System. 

WARNING: The correct project Coordinate System needs to be selected in order for the graphical 
elements in the ORD File to be geo-referenced.  If the appropriate Coordinate System is NOT set, then the 
ORD File will be in the wrong geographical location.  If unsure about the Coordinate System, then locate 
the Survey Information Cell shown in the Survey ORD File.  The Survey Information Cell is discussed in 
5A.2 Review the Survey ORD File before Designing. 

 

 

From the Ribbon, select the Coordinate System tool: 
[OpenRoads Modeling → Utilities → Geographic]. 

TIP: Alternatively, access the Coordinate System tool through the Search Bar in the upper-right 
corner.  In the Search Bar, type in in “Coordinate System”. 

Within the Coordinate System tool, there are two methods for setting the project Coordinate System: 

 
1. From Library – The project Coordinate System is selected from an extensive list of 

Coordinate Systems that are used around the world. 

 
2. From File – The project Coordinate System is automatically matched from a different ORD 

File – such as the Survey ORD File. 

BEST PRACTICE: Typically, the Survey ORD File is created before other files in the project are created.  
The Survey File should be set to the correct project Coordinate System.  Use the From File method in and 
select the Survey File to set the Coordinate System for a new ORD File. 

The From Library method should only be used when absolutely necessary.  The From Library contains a 
list of hundreds of coordinate systems – many of which look identical but are actually slightly different.  
The From File method eliminates the risk of mistakenly selecting the wrong coordinate system. 
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From Library  method: 

TIP: The project Coordinate System is specified in the Survey Information Cell found in the Survey ORD 
File.  See 5A.2 Review the Survey ORD File before Designing. 

 

 

 

In the Coordinate System Menu, select the From Library button.  

 
In the Library List, navigate to and select the project Coordinate System. 

 
Select the OK button. 
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From File  method: 

 

 

In the Coordinate System Menu, select the From File button.  

 

Select the ORD File that will be used to match Coordinate Systems. 

NOTE: Use only an ORD File that is known to contain the correct project Coordinate System, such 
as the Survey ORD File.  

 
Select the Open button. 
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Coordinate System Confirmation: The User can confirm the proper Coordinate System is set by 
toggling ON the Background Map.  Simply, open the View Attributes and change Background Map Type to 
Aerial.  If the View window is positioned in the geographical vicinity of the project, then the aerial should 
align with the Survey ORD File and other Design ORD Files. 



 

3-21 

3D.2 Reference in the Survey ORD Files and Design ORD Files 

After the Coordinate System has been set, other ORD Files can be Referenced into the new ORD File.  The 
procedure for referencing an ORD File is shown in 1E.1 Create a Reference – Workflow. 

The Survey ORD File must be referenced to show existing features and Existing Ground Terrain Model. 
Design ORD Files are Referenced in to show proposed features. 

For an overview of how different ORD Files are arranged and Referenced in a typical project, see 2F.1 
Project Organization and Referencing Map for ORD Files. 

Survey ORD Files 
• Existing Survey File 
• Existing Right-of-Way File 
• Existing Ground Terrain Model File 

Design ORD Files 
• Alignment File [Highway Design] 
• Corridor File [Highway Design] 
• Bridge Design [Functional Design Area] 

The Survey and Design ORD Files listed above are used to show all existing features and proposed road 
work.  Other additional Design ORD Files may need to be referenced into to show other design features. 

WARNING: Nested Referencing should be turned OFF when referencing files into a new ORD File.  For 
more information on Nested Referencing, see 1E.4 Nested Attachments in Drawing Models and Sheet 
Models. 

The graphic below shows the References Manager used in an example Road Plan and Profile Plan Sheet 
ORD File. 

For an overview of the Reference Manager and how to Reference an ORD File, see 1E – References. 

 

TIP: To correctly display Clipped Corridor linework (i.e., clipped linework around intersections or 
approaches), then the 3D Design Model  (Default 3D) has to be Referenced in addition to the 2D 
Design Model  (Default).  In this case, the Corridor File (_cor.dgn) is Referenced twice to show both 
Models.  See 9G.10.b Displaying Corridor Clipping References - WARNING 
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3D.3 Activate the Existing Ground Terrain Model 

After the Survey ORD File has been Referenced into the new ORD File, the Existing Ground Terrain Model 
should be immediately Activated. 

An ORD File may contain many Terrain Models; however, only one Terrain Model can be active at a given 
time.  In almost all situations, the Existing Ground Terrain Model should be the active Terrain Model. 

The Existing Ground Terrain Model must be active in order to display the existing ground profile line in the 
Profile Models . Also, the End Condition Points for a Corridor will seek out the Activated Terrain Model. 

Activate a Terrain Model with the Pop-Up Icon Menu: 

 

Left-Click and hover over the Terrain Model with the mouse cursor until the Pop-Up Icon Menu 
appears. 

 In the Pop-Up Icon Menu, select the Set As Active Terrain Model tool . 

Activate a Terrain Model with the Ribbon: 

 

Left-Click on the Set Active tool under the Active dropdown. 

 
Prompt: Locate Terrain Model to set as Active – Left-Click on the Terrain Model to complete the 
command. 

Activate a Terrain Model with the Project Explorer: 

 

Locate the Terrain Model in the Project Explorer. 

 
Right-Click on the Terrain Model and select the Set as Active Terrain Model option. 
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3D.3.a Creation of the 3D Design Model after Terrain Model Activation 

Initially, a new ORD File will only contain the 2D Design Model .  When a Terrain Model is Activated, the 
software automatically creates a 3D Design Model . 

This process occurs because the new ORD File is initially a 2-dimesonal space.  A 3-dimensional space is 
needed to interact with the Activated Terrain Model. 

After the Terrain Model is activated, the newly-created 3D Design Model  is automatically Referenced 
into the 2D Design Model .  This is awkward because it appears that the ORD File is Referencing itself.  
However, the 3D Design Model  reference is used to display “flattened” 3D elements in the 2D Design 
Model . 

BEST PRACTICE: After activating the Terrain Model, turn OFF the display of the 3D Design Model  
reference in the 2D Design Model . 
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3E – IMPORT SUPPLEMENTING DATA 

3E.1 Import Google Earth Aerial Imagery 
The procedure in this section explains how to import a Google Earth aerial into the new ORD File.  
Additional procedures for importing georeferenced rasters is shown in 24B – Import Georeferenced Aerials 
(Rasters and .ECW). 

PLAN SHEET PRODUCTION WARNING: The User will have very little control of the brightness and 
contrast of the resulting Google Earth aerial image, which makes this procedure of limited use for display 
in plan sheets.  The resulting Google Earth aerial image is actually a Mesh element, which does not allow 
for direct visual adjustments.  The resulting aerial image is intended for a design backdrop, instead of for 
use in plan sheets. 

TIP: The Background Map feature (located in the View Attribute menu) can be used to quickly display 
aerial imagery provided by Bing.  See 1B.5 – The Background Map. The following procedure for importing 
Google Earth imagery is more complicated and time consuming.  This procedure should only be performed 
if specifically required to view aerial imagery provided by Google – for example to view a historical aerial. 

GOOGLE EARTH WARNING: The current version of Google Earth Pro is NOT compatible with the ORD 
Software.  A previous version of Google Earth has to be installed on the User’s machine to perform the 
following workflow.  Install and use the “v7.1.8.3036” version of Google Earth Pro to perform the following 
procedure: https://support.google.com/earth/answer/168344?hl=en   

WARNING: Before this procedure can be performed, it is necessary to set the ORD File to the correct 
Coordinate System.  See 3D.1 Set the Coordinate System. 

WARNING: This procedure can ONLY be performed in a View window displaying the 3D Design Model .  
Before performing this procedure, ensure the View is NOT displaying the 2D Design Model .   
NOTE: If the ORD File is newly-created, it will not contain a 3D Design Model  until a Terrain Model is 
activated. 

Ribbon Location for Google Earth Tools: Drawing workflow → Utilities tab → Geographic panel. 

Google Earth Tool Description 

 

Open Location 
in Google Maps 

When this tool is used, Google Maps is automatically opened in Internet 
Explorer.  The location shown in Google Maps window will correspond with the 
position of the View in the ORD Software. 

 

Synchronize 
Google Earth 

View 

When this tool is used, Google Earth Pro is automatically opened.  The location 
shown in the Google Earth window will correspond with the position of the View 
in the ORD Software 

 
Follow Google 

Earth View 
When this tool is used, the View position in the ORD Software is automatically 
re-positioned to correspond with the location shown in Google Earth. 

 

Capture Google 
Earth Image 

When this tool is used, the aerial imagery displayed in the Google Earth 
window is automatically imported into the current ORD File.  This tool is 
covered extensively in the following workflow. 

 

Export Google 
Earth File 

When this tool is used, the linework displayed in the current ORD File is 
exported as a Google Earth .KMZ File.   See 24D – Create a Google Earth KMZ 
from an ORD File. 

 
Google Earth 

Settings 
Used to alter settings related to the Capture Google Earth Image and 
Export Google Earth File tools. 

https://support.google.com/earth/answer/168344?hl=en
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IMPORTANT: Before initiating this workflow, open the Google Earth software.  Both the Google Earth and 
ORD software should be running side by side for this workflow.  See GOOGLE EARTH WARNING on the 
previous page. 

 

 

In a View window showing the 3D Design Model , zoom out so the entire area to be included in the 
aerial is shown.   

 

Select the Synchronize Google Earth View tool from the ribbon.  

Ribbon Location: Drawing workflow → Utilities tab → Geographic panel. 

This tool will automatically position the Google Earth window in the approximate area displayed in 
the 3D Design Model  View.  If Google Earth Pro is not already opened, the tool has to be clicked 
twice. 
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Within Google Earth Pro: 

In the upper-right corner, go to: File → Save → Save Image… 

After this step, a ribbon with Save options will appear at the top of the Google Earth window. 

NOTE: When this ribbon appears, the vertical extent of the Google Earth window is slightly reduced. 
This step has to be performed before the Capture Google Earth Image tool is used in Step 6.  If this 
step is performed after Step 6, the resulting aerial imagery in the ORD Software will be distorted 
because the vertical resolution will not align. 

 

Within Google Earth Pro: Modify the Save options in the ribbon: 

In the Map Options dropdown: Uncheck all boxes. 
In the Resolution dropdown: Change the resolution to Maximum. 

Do not select Save Image… in this step.  

 

Within Google Earth Pro: 

Manipulate and position the Google Earth Pro window so that the intended capture area for the 
project is shown. 

DO NOT REPOSITION THE GOOGLE EARTH WINDOW FOR THE REST OF THE PROCEDURE. 

NOTE: The ORD Software will capture the exact area shown in the Google Earth Pro window – not 
the area that is shown in the ORD Software at the time of capture. 
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Within the ORD Software: 

Select the Capture Google Earth Image tool.  

Ribbon Location: Drawing workflow → Utilities tab → Geographic panel. 

Prompt: Capture Google Earth Image > Enter datapoint to capture the current Google Earth View. – 
Left-Click in the 3D Design Model  View to capture the aerial shown in Google Earth Pro. 

 

After Step 6 is performed, a white grid will be created in the 3D Design Model  View.  The 
rectangular extent of this grid exactly aligns with the Google Earth Pro window. 

Additionally, a .jpg image file is automatically placed in the same folders as the ORD File.  The .jpg 
image file will have the same name as the ORD File with “TerrainCapture1” added to the end. 
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By default, the aerial imagery is shown in grayscale.  This is a limitation of the ORD Software, and 
CANNOT be rectified with a setting change. 

Also, the resolution of the default aerial imagery is poor.  To rectify these two shortcomings, a custom 
image will be saved from Google Earth and will replace the .jpg file (shown in Step 7) that is tied to the 
Mesh element. 

 

To show the aerial image, change the Display Style of the 3D Design Model  View.  The Display 
Style must be set to Smooth. 

View Attributes → Display Style → Smooth. 

The white grid is actually a Mesh element.  The Mesh element is NOT “flat”.  It is a 3D element 
that contains elevation data provided by the Google. 

TIP: A Terrain Model can be created from the Mesh element by using the From Elements tool. 

Also, the aerial image is NOT “flat”.  It is draped atop of the 3D Mesh element.  The aerial imagery 
and 3D Mesh element are considered a singular element entity by the ORD Software. 

The source of the default aerial imagery is the .jpg file shown in Step 7.   
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After completing Steps 9-11, the default aerial image – which is in grayscale - will be replaced by a high 
resolution, color aerial image. Exit out of the ORD Software and reopen the ORD File to view the new 
colorized aerial image. 

 

Within Google Earth Pro: 

Select Save Image… from the Save options ribbon. 

WARNING: If the position of the Google Earth window has changed since using the Capture Google 
Earth Image tool in Step 6, then the aerial imagery will be distorted after this step.   

 

Navigate to the project folder. 

Ensure the Save as type is set to JPEG Image (*.jpg). 

Left-Click (highlight) the default aerial image (in this case “id-
a2158061_IMAGETerrainCapture1.jpg”) 

Click the Save button 

 When prompted to replace the current image file – Click the Yes button. 
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Viewing the Aerial Image in the 2D Design Model : 

When viewing the aerial image from in the 2D Design Model , it will cover up all linework and graphical 
elements.  Rectify this by re-ordering the Referencing Sequence found in the Reference Manager. 
NOTE: The Referencing Sequence is discussed in 1E.7.b Update Sequence (Reference Layering). 

 

Open and activate a View window showing the 2D Design Model . 

Open the Reference Manager: 

Go to Properties → Update Sequence. 
Move the 3D Design Model  to the top of Sequence List.  Push the OK button 
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Manipulate the Brightness of the Aerial Image in the 2D Design Model : 

 

To manipulate the brightness and contrast of the aerial image in the 2D Design Model : 

In the Reference Manager, Right-Click on the 3D Design Model  reference and select 
Presentation.  Change the Display Style from “(From Parent)” to “Smooth” 

NOTE: The brightness and contrast of the aerial image CANNOT be adjusted directly.  Instead, the 
Display Style of the 3D Design Model  is manipulated to achieve the desired brightness settings. 
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Manipulate the Brightness of the Aerial Image in the 3D Design Model : 

 

 

Open a View displaying the 3D Design Model  

From the View Attributes Menu, open the Display Style Editor. 
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3E.2 Import Alignments (.GPK Files) Created in GEOPAK 

The Import Geometry tool is used to import alignments and profiles created in legacy versions of the ORD 
software – such as GEOPAK and InRoads.  Before this workflow is performed, ensure that the Coordinate 
System has been set.  See 3D.1 Set the Coordinate System. 

In this workflow, an alignment and profile created in GEOPAK is imported into the ORD File.  The name of 
the alignment is “BT_1” and the corresponding profile is named “PRO_BFS_A1”. 

 

 

Select the Import Geometry tool from the ribbon. 

Ribbon Location: OpenRoads Modeling workflow → Geometry tab → General Tools panel. 

 Navigate to the folder location for the .GPK File to be imported.  

 Highlight the .GPK File (in this case “Riverside Road_GEOPAK.gpk) and push the Open button. 
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NOTE: When Alignment and Profiles are imported through this method, they will NOT contain a Feature 
Definition.  Be sure to apply a Feature Definition to both the Alignment and the Profile (contained in the 
Profile Model ).  The alignment and profile should be placed on an Alignment Feature Definition (i.e., 
Baseline, Baseline – Alt 1, etc..).  To assign the Alignment/Profile a Feature Definitions, see 7B.3.b Change 
Feature Definition with Set Feature Definition Tool. 

 

CHECK the boxes of the Alignments and Profiles to import. 

NOTE: Profiles can be found in the dropdown of each Alignment. Import only the Profile that 
corresponds to the selected Alignment. 

 

If the Create Civil Rules box is CHECKED, then the alignment will be created as an EDITABLE 
Complex Element.  The alignment will contain Civil Rules, which means the alignment contains 
manipulators – such as grips to perform grip edits.  For more information, see 7C.2 Civil Rules 

If the Create Civil Rules box is UNCHECKED, the alignment will be UNEDITABLE.  The alignment 
will NOT contain Civil Rule Manipulators.  The User will be unable to perform edits – such as grip-
edits. 

TIP: Use the Simplify Geometry tool to restore Civil Rules to a uneditable Alignment. 

 
Push the Import Button 
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3E.3 Import AutoCAD Files 

Reference AutoCAD Files : 
AutoCAD Files (.DWGs) can be Referenced into an ORD File with the Attach Reference tool.  The process of 
referencing an AutoCAD Files is performed exactly the same as referencing another ORD File.  See 1E.1 
Create a Reference – Workflow. 

WARNING: Occasionally, AutoCAD Files use INCHES for the master units.  For example, AutoCAD Files 
containing architectural building plans are often drawn in inches.  These AutoCAD Files may be enlarged 
by a scale factor of 12 when referenced into ORD File.  User the Scale tool to reduce the size of a inch unit 
file by a factor of 0.083333.  See 1E.6.c Scale a Reference. 

After an AutoCAD File is referenced into an ORD File, it can be manipulated and scaled in the Reference 
Manager in the same fashion as a refenced ORD File.  See 1E.5 Manipulating References (Move, Rotate, 
and Scale). 

Merge AutoCAD Files into the ORD File: 
Once an AutoCAD File (.DWG) is referenced into an ORD File, the Merge Into Master tool can be used to 
import the contents of the AutoCAD File directly into the ORD File.  After the Merge Into Master tool is 
used, the AutoCAD linework and text can be directly edited and manipulated.  For more information, see 
1E.7.a Merge Into Master tool (Import Reference into Current ORD File). 

When the Merge Into Master tool is used, simple AutoCAD linework – such as Lines and Arcs – will be 
converted into similar MicroStation Elements.  AutoCAD elements that are comprised of a series of lines 
and arcs will be converted into MicroStation Line String elements. 

WARNING: If AutoCAD linework is subject to change, then the Merge Into Master tool should NOT be 
used. For example, if an AutoCAD File is needed to simply display architectural building linework, then it is 
advantageous to leave the AutoCAD File as a Reference.  If left as a Reference, then a dynamic link is 
maintained to the AutoCAD File.  Any changes or updates to AutoCAD File will be reflected in the ORD File. 

Civil Data Loss From AutoCAD Files with 3D Features 
Typically, simple AutoCAD elements – such as lines, arcs, and texts – are referenced, displayed, and 
merged into an ORD File with no issues.  However,  AutoCAD elements that contain intelligent and 3D 
features – such as Alignments, Profiles, Corridors, Surfaces, Feature Lines, Blocks, and COGO Points – 
may behave erratically when referenced into and ORD File.  It is common for AutoCAD 3D elements to be 
“flattened” and appear distorted when referenced into OpenRoads Designer. 

AutoCAD 3D Features may be visualized better if they are referenced into the 3D Design Model  of an 
ORD File.  The “Modelspace” in AutoCAD is a 3-dimensional space, which is similar in concept to the 3D 
Design Model  of an ORD File.  3D AutoCAD elements may behave more predictably if they are 
referenced into the 3D Design Model . 

Display and Print of AutoCAD Elements: 
The most significant challenge when working with AutoCAD Files is getting AutoCAD linework and text to 
plot, print, and display correctly.  AutoCAD elements will retain symbology properties (Layer, Color, Line 
Style, and Weight) that were applied to them in AutoCAD. 

AutoCAD elements are likely found on Layers that are NOT recognized by FLH Pen Tables.  In other words, 
the FLH Pen Tables have no effect on the printed display of AutoCAD Elements.    The Levels imported 
from AutoCAD may need to be altered for compatibility with the FLH Pen Table.  Modifying Levels is 
accomplished in the Level Manager.  See 1G.5 Level Manager.  The FLH Pen Table is discussed in 19D – 
The FLH Pen Table, Custom Levels, and AUX Levels. 
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3F – NAMING CONVENTION FOR PROPOSED ORD FEATURES 

Alignments, Profiles, Corridors, and Terrain Models should be assigned an appropriate name that adheres 
to the naming convention discussed in this section. 

IMPORTANT: Names assigned to proposed ORD features are shown in the Physical Data, which is used 
for construction staking.  Assign logical names so construction contractors and surveyors can identify the 
proposed feature within the Physical Data files. 

NOTE: This naming convention may be modified to better describe the proposed features unique to the 
project. 

The name of a feature consists of three descriptors: the ORD Entity Type, Feature Type, and an Identifier. 

Example Feature Name: ALI_APPR_Maple 

 [ORD Entity Type] _ [Feature Type] _ [Identifier] 
 [ALI] [APPR] [Maple] 

This feature would be used to represent a Horizontal Alignment [ALI] for an Approach Road [APPR] with 
the real-world name: Maple Street [Maple] . 

An Alignment typically has a corresponding Profile and Corridor.  The name for the Alignment, Profile, and 
Corridor should be identical, but contain different prefixes to identify the element type.  For example, the 
ORD Entities that represent the mainline of “Riverside Road” would be named: 

ALI_MAIN_Riverside (Horizontal Alignment name) 
PRO_MAIN_Riverside (Vertical Profile name) 
COR_MAIN_Riverside (Corridor name) 

ORD Entity Type: The ORD Entity Type is used to readily identify the type of ORD Element that a feature 
represents.  The ORD Entity Types are limited to: Alignments, Profiles, Corridors/Linear Templates, and 
Terrain Models. The ORD Entity Type should be typed in ALL CAPS. 

ORD Entity Type Descriptors 
ORD Entity Type Description 

ALI Horizontal Alignment  

PRO Vertical Profile 

COR Corridor Model or Linear Template Model 

TER Terrain Model 
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Feature Type: The Feature Type is used to classify the feature.  The table below lists some common 
Feature Types.  The User may create a custom Feature Type identifier, if one cannot be found in the table 
below.  The ORD Feature Type should be typed in ALL CAPS and should be 4 letters or less. 

Feature Type Descriptors 
Feature Description 

MAIN Mainline Roadway 

APPR Approach Roads 

DRWY Driveway 

PARK Parking Lot 

HYDR Hydraulic/Drainage Features 

CULV Culvert 

DTCH Ditch 

WALL MSE Wall 

DETR Temporary Diversions/Detours 

CURB Curbing 

SDWK Sidewalk 

Identifier: The Identifier relates directly to the real-world name for a feature.  For example, a culvert 
alignment on a stream called “Salt Creek” create may be named: “ALI_CULV_Salt”. 

If a feature does not contain a real-world name, then a two-digit numerical code may be assigned as the 
Identifier – such as: “03”.  For example, the fourth approach road alignment in a project may be named: 
“ALI_APPR_03”. 

Alternatively, the mainline station where the feature is found may be used an Identifier.  For example, a 
driveway alignment at STA 10+62 may be named “ALI_DRWY_1062. 

The Identifier should be typed out in Mixed Case (which means the first letter should be capital and the 
following letters should be lower-case).  For example: “ALI_MAIN_Riverside”.  The Mixed Case spelling 
helps to visually distinguish the identifier from the ORD Entity Type and Feature Type. 

In some cases, an Identifier may NOT be necessary to describe a feature and distinguish it from other 
features in the project.  In these cases, it acceptable to omit the Identifier.  For example, if a project 
contains a single mainline alignment, then the name “ALI_MAIN” would be sufficient to distinguish it from 
other features in the project. 
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